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INTRODUCTION 
SpeechControl4Mac has been designed to control different applications on a Mac with a Philips 
SpeechMike III and a SpeechMike Premium. 

 

The software allows to assign different functions to each button, enable or disable certain features, 
and also to control applications via hotkeys. For text generation you can simply write the specified 
text with a button click into the text editor.  

Even more advanced, you can quickly execute your favorite Dragon Dictate 5 commands with just a 
button click on the device. 

 

The device configuration settings can be loaded from and saved to the device. You can also restore 
the default device configuration settings and save them to the device. 

When starting Philips SpeechControl4Mac, the settings are automatically loaded from the connected 
active device. Changes made with other applications on the active device after the first startup are 
not downloaded to SpeechControl; you have to download them manually. If a device is already 
connected to the computer and you additionally connect another device, the second connected 
device becomes the active device. The device configuration settings will be loaded automatically. 

 

To change the behavior of the active device and configure the buttons, go to the Device page.  

To make configurations on the active device for handling different applications, go to the Application 
Control page.  

When encountering problems, you can try to find a solution in the help. 

 

Back to Table of Contents 

 

INSTALLATION 

 Copy the ‘SpeechControl3.3.08.dmg’ file to the disk drive of your Mac. 

 When opening the file you will see following screen 

 

 Drag the SpeechMike icon to the Applications folder to start installation

D Note: to manually start installation go to the finder and select the disk drive. To install 
SpeechControl4MAc move SpeechControl.app to the 'Applications' folder. 

 

Back to Table of Contents 
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SUPPORTED PLATFORMS 

MAC PLATFORMS 
SpeechControl4Mac 3.3 is tested with the following Mac operating systems: 

 Mac OS X 10.10 Yosemite 

 Mac OS X 10.11 El Capitan 

 

 
For all listed operating systems, it is recommended that the latest service pack available is applied 
before installing SpeechControl4Mac. 
 

SPEECH RECOGNITION SOFTWARE 

SpeechControl4Mac 3.3 works with the following speech recognition application: 

 Dragon Dictate 5 

 

SPEECHMIKE 
SpeechControl4Mac 3.3 supports following SpeechMike versions: 

 SpeechMike Pro 3200 series 

 SpeechMike Barcode 3300 series 

 SpeechMike Premium 3500 series 

 SpeechMike Premium Barcode 3600 series 

 SpeechMike Premium Touch 3700 series - NEW 

 SpeechMike Premium Barcode Touch 3800 series - NEW 

 

D Notes:  

 SpeechMike II (LFH 52xx) and SpeechMike Air (LFH 30xx) devices are not supported. 

 SpeechControl4Mac does not support SpeechMike Premium devices which are set to 
“keyboard mode” 
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SPEECHCONTROL MENU 
The SpeechControl menu provides the following options: 

 

 

Menu entries 

The SpeechControl menu has following entries: 

 

 

About box 

The About box shows the current version of your SpeechControl4Mac application.  
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Edit Menu 

The Edit menu shows following important entries: 

 

Use the “special character” menu entry when programming text macros with special characters to a  

SpeechMike button 

 
 

D Note: When programming hotkeys the “special character” menu is disabled. 

 

Window menu 

The Window menu shows following entries: 

 

 

Help menu 

The Window menu shows following entries: 

 

 

Back to Table of Contents 
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TOOLBAR 
The SpeechControl toolbar shows following items: 

 

Device  

Clicking the Device item views the Device page. This item is only enabled if a valid device is 
connected. 

 

Application Control  

Clicking the Application Control item views the Application Control page. This item is only enabled if a 
valid device is connected. 

 

Introduction  

Clicking the Introduction item views the Introduction page. The Introduction page is shown by default 
if no valid device is connected. 

 

Active device  

This text field shows the currently active device. The settings of that device can be configured on the 
Device page, the application control options for that device can be configured on the Application 
Control page.  

If no valid device is connected, the text field shows "No device connected" 

 

Device details  

When clicking on this item, a sheet is displayed showing the details for the active device: 
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DEVICE CONFIGURATION 

General 

 
On the Device page you can customize the behavior of the active device, configure its buttons and 
upgrade its firmware. After starting SpeechControl, the current settings of the connected device are 
automatically loaded and displayed in the UI.  

You can also load the settings from the device manually by clicking the  button. 

After changing the settings in the UI, you can save them to the device by clicking the 

button.  

By clicking , the factory settings for the connected device are loaded and displayed in 

the UI.  

 

After that, click Save to device  to save the factory settings to the connected device.

D Note: It is not possible to configure more than one connected device at once. When connecting a 
second device to your Mac, it automatically becomes the active, configurable device. 

 

Following settings are available on the Device page: 

 

D Note: The availability of the above settings depends on the type of the active device. 
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Device Test 

To test the currently active connected SpeechMike simply click on any button. 

 

The „last event“ field will show the most recent button event that was recognized by 
SpeechControl4Mac.

D Note: If you do not see a change when clicking a button please check your SpeechMike settings 
whether the button is disabled or to check the USB connection to the SpeechMike.  

 

Back to Table of Contents 

 

Settings 

Here you can customize the basic behavior of the active device.  

D Note: The available options depend on the type of the active device. 

 

 

Mouse  

Here you can make general changes to the mouse functionality of a SpeechMike.  

You can also disable all mouse functionality (Trackball and mouse buttons). 

 

Mouse style 

Right handed mouse style means the primary mouse button is the left mouse button, left handed 
mouse style means the primary mouse button is the right mouse button. 

You can also configure a custom mouse style and directly map the desired events to the mouse 
buttons on the device.  

Custom mouse style configuration is the same as standard Button Configuration, but only for mouse 
related buttons on the device. 
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Enable Drag lock 

Activate this option to pick up a selected item by pressing the mouse button for more than the 
specified duration.  

To drop the item just briefly press the button again. 

 
 

Pointer  

Here you can set the cursor speed of the active device.  

Furthermore, you can enable dynamic pointe behavior which accelerates the mouse cursor when 
quickly moving the trackball or when quickly swiping over the touch sensor. 

 
 

Back to Table of Contents 

 

Advanced Settings 

Here you can customize the advanced behavior of the active device.  



D Note: The available options depend on the type of the active device. 

 

Button click noise filter 

Enable this option to suppress all acoustical button clicks during recording. 

 

Lock device bit 

Here you can set the lock device bit stored on the active device.  

This setting is important for integrators only and has no effect on SpeechControl4Mac. 
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Low power mode 

Enable this option to set the USB power mode to Low power mode.  

In “Low power mode” the SpeechMike requires less than 100 mA, which is needed in case the USB 
port on the Mac does not comply with the USB standard (500 mA). 

D Note: By default SpeechMike III and SpeechMike Premium are already designed as “low power” 
USB devices. Therefore this setting is obsolete for the two mentioned devices 

 

Target OS 

Select whether you want to use the device on a Mac or on a Windows PC.  

It is strongly recommended to use Mac OS as Target OS when working on a Mac.  

If Windows is selected, the recordings with the SpeechMike might be distorted. 





D Note: When connecting a SpeechMike with Windows OS configuration SpeechControl4Mac will 
display following dialog  

 
 

B IMORTANT:  

 If you want to move your device back to a Windows PC and use it to work with Philips Speech 
Processing software, you must switch the target OS back to Windows OS and save the 
settings to the device.  

 Otherwise, the device will not be recognized by any older Windows based dictation software!  

 It is not possible to switch to the Windows mode on Windows operating systems. 

 

Switching back to Windows OS 

 Switch the target OS back to Windows OS and save the settings to the device.  

 

 Save the settings to the SpeechMike by clicking the Save to device button. 
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Barcode scan mode 

Here you can set the operation of the barcode scanner. 

Scan to application focus (keyboard mode) 

Works as a secondary keyboard connected to the computer.   

Scan to specified fields (event mode) 

Generates a special barcode event when a barcode is scanned. This option requires special barcode 
event integration. 



D Note: This option is only available for devices with built-in barcode scanner. 

 

Back to Table of Contents 

 

Microphone motion control 

Here you can set how the microphone of the SpeechMike Premium changes the input level of the 
microphone while the device is laid down. 

Disable microphone motion control 

The input level of the microphone does not change while the device is placed. 

 

Reduce input level 

Automatically reduces the microphone input level by 20 dB while the device is placed. 

 

Mute microphone 

Automatically mutes the microphone while the device is placed. 
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Button Configuration 

Here you can switch the function events of the SpeechMike buttons on the active device to meet your 
personal requirements. 

 
 

Configuring the button function 

 Click the arrows of the combo box cell in the Event column for the button you want to 
configure. 

 Select the event to be associated with the button. 

 

 Save the settings to the active device by clicking the Save to device button. 



D Note: If the active device has a built-in barcode scanner, the Barcode trigger option can also be 
enabled to scan the barcode by pressing the button. 

 

Back to Table of Contents 
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Firmware 

Here you can load the latest firmware version into the active device. 

D Note: Firmware upgrade is possible only in Stop state (device is not recording not playing back). 

 

 

The Firmware upgrade process 

 Select the firmware file to be loaded to the device. 

 

 Click Upgrade firmware.  

 The Firmware upgrade sheet is displayed: the upgrade process can be followed on a 
progress bar. 

 

 The device is ready to use again after the sheet is getting closed. 

 

 

Back to Table of Contents 
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APPLICATION CONTROL 

 
On the Application Control page you enable to control other applications (for example, Dragon 
Dictate or TextEdit or any other application in focus) with the active device by assigning different 
operations (like hotkeys or Dragon commands) to buttons on the device.  

 

Application Control provides three profiles by default, which can be selected by clicking the popup 
button on top of the page.  

 

Each profile has a different Button Event-to-operation-mapping, which you can see in the table 
below.  

The following image is showing the default mapping table for the Dragon Dictate profile:  

 
You can configure the mappings by clicking an item in either the "Pressed" or the "Released" column 
for Button events and "Picked up" or the "Laid down" column for Motion events, which brings up the 
Edit operation sheet.  
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D Notes:  

 Only the selected profile is active. It is not possible to have more than one active profile 
simultaneously.  

 All operations, except some Dragon commands which can only be handled by Dragon, are 
carried out on the application which is currently in focus. 

 Application Control can be deactivated by unchecking the "Activate Application Control" checkbox 
below the mapping table. 

 

Edit operation 

Operations can be created both for the button pressed and button released events by clicking an 
item in the mapping table´s "Pressed" or "Released" column accordingly.  

See in the following the steps for creating and editing an operation: 

 

Creating and editing an operation 

 Click an item in the mapping table.  

 The Edit operation sheet is displayed, where you can configure a list of operation steps. 

  

 Enter a name for the operation. This name will be shown in the mapping table. 

 Click Add. The operation step editor is displayed.  

 

 Specify the type of the operation, click Next and make the required settings. 
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 Click Finish to save the changes. The edit operation sheet is displayed again, where further 
operations can be added, or already existing ones can be edited, deleted or moved up/down in 
order. 

 Click OK. 

 

Operation types 

 Hotkey 
Sends a specified hotkey with the optional modifier (Shift, Command, Control, Option) to the 
application in focus by pressing the selected button on the active device. Could be used to reach 
a menu item or change the screen resolution. 
 

 Text 
Sends a specified text to the application in focus by pressing the selected button on the active 
device. 

D Note: You can also insert special characters with the use of the “special characters” menu. 
 

 Dragon command 
Executes the selected Dragon Dictate command by pressing the selected button on the active 
device. 
Following Dragon commands are available:  

 
 

 Delay 
Suspends the execution of a command for the specified time. 
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WORKING WITH DRAGON DICTATE 5 

Default configuration 

 

Start dictation 

To start dictation put the cursor focus to the text editor and simply click on the “Record”  
button of your SpeechMike. 

The record icon of Dragon Dictate will switch to green and the record LED of the SpeechMike will 
light up 

 
 

 

 

 

 

 

D Note: The default record setting is “Record Toggle” mode. 

 

Stop dictation

BIMORTANT:  

Before stopping dictation wait until all text has been completely recognized and put to the text 
editor’s window. 

Otherwise Dragon Dictate might drop the words, or commands which have not been recognized yet. 

 

To stop dictation simply click on the “Record” button  of your SpeechMike (when using the default 
record mode). 

 

D Note: If you have switched your SpeechMike to “push-to-talk” mode you need to wait until the 
text has been completely recognized before releasing the record button. 
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Moving the cursor 

To move the cursor with in the document simply click on “Forward”  to move the cursor forward or 

click “Backward”   to move the cursor backwards. 

 

Selecting words 

To select words backwards (e.g. for correction) simply click on the “EOL” button  on your 
SpeechMike. 

 

Correcting mistakes 

To correct mistakes simply position the cursor with Forward or Backward at  the end of the wrong 
word, select the wrong text with the EOL button of your SpeechMike and click on the INS/OVR button 

 of the SpeechMike to display the recognition window.  

 
To select the correct phrase or text either speak the "Choose #" command or choose the appropriate 
line with SpeechMike mouse functions. 

 

E Tip: The recognition window will only show the last utterance. This is a Dragon Dictate behavior 
and cannot be changed. 

As a workaround to correct a single word you can try to mark the word with the EOL button and 
speak over it. 

 

Playing back the recorded sound 

To play back the recorded sound, move the cursor to the appropriate position and click on the play 

button .  

D Note: If you have problems listening to the recorded sounds please check the audio settings of 
your Mac. 
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Advanced settings 

Switching speech modes 

Sometimes it is required to switch to speech mode during dictation. 

This can be reached by programming a hotkey to a SpeechMike button. 

By default the hot key for changing speech mode is "Command+F10” 

 
 

To program this command to a SpeechMike button selected program button and program the hotkey. 

 
 

To switch the speech mode simply click on the programmed SpeechMike button until you reach the 
desired one. 

 
 

Back to Table of Contents 
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FAQ’S 
Q.: What can I do with SpeechControl4Mac? 

A: With SpeechControl4Mac you can re-configure the SpeechMike and you can assign buttons to 
application functions. Additionally you can test your SpeechMike for button events and update your 
SpeechMike's firmware. 

 

Q.: Does SpeechControl4Mac always run in the background? 

A.: When using the typical setup option SpeechControl4Mac does not start up automatically.  

To enable autostart after login do following: 

1. Go to the Dock and click the right mouse button on the Dock icon  

2. Go to ‘Options’ and enable ‘Open at Login’ 

 

Q.: How do I know that SpeechControl4Mac is currently running? 

A.: When SpeechControl4Mac is currently running an  icon is shown in the Dock. 

 

Q.: Can I enable the auto-start option of SpeechControl4Mac? 

A.: Yes, you can modify the startup options in the SpeechControl4Mac options in the Dock. 

 

Q: How can I use the Philips slide switch SpeechMike with Dragon NaturallySpeaking?  

A: The record button of the SpeechMike Classic (Philips slide switch) is preconfigured with the 
Record-Toggle function. The four position switch operates as it is printed on the device (e.g. PLAY 
starts playback, fast forwards moves the cursor forwards,...).  

 

Q: Why is "Record Toggle" the default setting for the record button?  

A: According to user feedback “record toggle” is the most convenient recording mode.  

Additionally this method reduces the risks of losing recognized texts by releasing the record button 
too early compared to the “push-to-talk” mode. 

 

Q: Can I switch the record button from toggle mode to push-to-talk?  

A: Yes, this can be done. Just change the “button pressed” event to “microphone on” and add the 
"Microphone off and stop" command to the "button release" event.  

Then the microphone is switched on when pressing the record button and switched off when 
releasing the record button. 

 
 

Q: Can I switch my SpeechMike Classic to a “German” slide switch stype? 

A: Yes, if you have a SpeechMike 3220 or 3520 this can easily be done in the button configuration 
tab. Simply exchange the PLAY and the STOP function and upload the setting to the SpeechMike. 

 

Q: Can I use SpeechControl4Mac on Linux operating systems? 

A: No, the application is designed for Mac operating systems only  

 

Q: Can I use the application control with my Philips Digital Pocket Memo? 

A: No, SpeechControl4Mac has been designed to control other applications with Philips 
SpeechMikes only.  
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Q.: Can I program all Dragon commands on my SpeechMike buttons? 

A.: SpeechControl4Mac offers the most important functions for Dragon Dictate 5 in its feature set. 
Specific macros or commands cannot be programmed to the SpeechMike buttons.  
Please use the spoken commands instead. 

 

Q: Will it be delivered automatically with the HW? 

A.: No, SpeechControl4Mac can only be downloaded from the SpeechMike support pages 

 

Q: Will it be possible to configure the Digital Pocket Memo (DPM)? 

A.: SpeechControl4Mac can configure Philips SpeechMikes III and SpeechMike Premium only.  

 

Q: Can you set the buttons to toggle / continuous 

A.: Yes, this can be done with the “button pressed” and “button released” event. 

 

Q: What versions of Dragon Dictate does SpeechControl4Mac work with? 

A.: SpeechControl4Mac 3.3 works with Dragon Dictate 5. 

 

Q: How much does this tool cost? 

A.: There is no extra charge for SpeechControl4Mac. 

 

Q: Where can we get this tool from?  Is it on the web? 

A.: SpeechControl4Mac can be downloaded from the Philips Speech Processing download area. 

 

Q: Can existing SpeechMike users obtain the tool from our web site at no extra cost? 

A.: Yes, it is downloadable for SpeechMike III and SpeechMike Premium from the SpeechMike 
support site.  

 

Q: Is there a minimum SpeechMike firmware version required for version use on a Mac? 

A: Yes, SpeechMike III requires firmware V1.14 or later. In case a SpeechMike III with an older 
firmware is connected you will be asked to upgrade your firmware. 

 
If you click “Upgrade” SpeechControl4Mac will upgrade the SpeechMike III firmware to version 1.14. 

 

Q: Does it matter in which order Dragon Dictate 5 or SpeechControl4Mac are installed?  

A: The installation order does not matter.  

If Dragon Dictate 5is already there you can also install SpeechControl4Mac afterwards and all works 
fine. 

 

 

Back to Table of Contents 
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MAC BASICS 
For all who are new to the Mac world please find below a short description of some basic Mac 
commands. 

This might be useful when programming shortcut keys to SpeechMike buttons. 

Modifyer Key symbols on a Mac 

Modifier key symbols you can see in Mac OSX menus: 

 (Command key) - On some Apple keyboards, this key also has an Apple logo ( ). 

  (Control key) 

 (Option key) - "Alt" may also appear on this key  

(Shift key)  

 (Caps Lock) - Toggles Caps Lock on or off 

 fn  (Function key) 

Basic keyboard shortcuts 

Basic finder keyboard shortcuts 

Key combination What it does 

Command-A 
Select all items in the front Finder window (or desktop if no window is 
open) 

Option-Command-A Deselect all items 

Command-C Copy selected item/text to the Clipboard 

Command-D Duplicate selected item 

Command-F Find any matching Spotlight attribute 

Shift-Command-F Find Spotlight file name matches 

Shift-Command-H Open the Home folder of the currently logged-in user account 

Command-M Minimize window 

Option-Command-M Minimize all windows 

Command-V Paste 

Command-X Cut 

Command-Z Undo / Redo 

Command-Shift-? Open Mac Help 

Command key while dragging 
Move dragged item to other volume/location (pointer icon changes while 

key is held--see this article) 

Option key while dragging 
Copy dragged item (pointer icon changes while key is held--see this 
article) 

 

Back to Table of Contents 

 

  

http://docs.info.apple.com/article.html?artnum=25571
http://docs.info.apple.com/article.html?artnum=25571
http://docs.info.apple.com/article.html?artnum=25571
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Basic application and other Mac OS X keyboard commands   

D Note: Some applications may not support all of the below application key combinations. 

Key combination What it does 

Command-Space 
Show or hide the Spotlight search field (if multiple languages are installed, may 
rotate through enabled script systems) 

Control-A Move to beginning of line/paragraph 

Control-B Move one character backward 

Control-D Delete the character in front of the cursor 

Control-E Move to end of line/paragraph 

Control-F Move one character forward 

Control-H Delete the character behind the cursor 

Control-K Delete from the character in front of the cursor to the end of the line/paragraph 

Control-L Center the cursor/selection in the visible area 

Control-N Move down one line 

Control-O Insert a new line after the cursor 

Control-P Move up one line 

Control-T 
Transpose the character behind the cursor and the character in front of the 
cursor 

Control-V Move down one page 

Option-Delete 
Delete the word that is left of the cursor, as well as any spaces or punctuation 
after the word 

fn-Delete Forward Delete (on portable Macs' built-in keyboard) 

Command-? Open the application's help in Help Viewer 

Shift-Command-3 Capture the screen to a file 

Shift-Control-Command-3 Capture the screen to the Clipboard 

Shift-Command-4 Capture a selection to a file 

Shift-Control-Command-4 Capture a selection to the Clipboard 

Command-A Highlight every item in a document or window, or all characters in a text field 

Command-B Boldface the selected text or toggle boldfaced text on and off 

Command-C Copy the selected data to the Clipboard 

Command-F Open a Find window 

Command-I Italicize the selected text or toggle italic text on or off 

Command-P Display the Print dialog 

Command-S Save the active document 

Shift-Command-S Display the Save As dialog 

Command-U Underline the selected text or turn underlining on or off 

Command-V Paste the Clipboard contents at the insertion point 

Command-X Remove the selection and store in the Clipboard 

Command-Z Undo previous command (some applications allow for multiple Undos) 

Shift-Command-Z Redo previous command (some applications allow for multiple Redos)

D Note: more detailed information about shortcut keys for Mac can be found in the Internet under: 
http://support.apple.com/kb/ht1343 

Back to Table of Contents 

http://support.apple.com/kb/ht1343
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ACRONYMS AND ABBREVATIONS 

DPM Digital Pocket Memo 

DSS Digital Speech Standard 

PSP Philips Speech Processing 

SDK Software Development Kit 

SM SpeechMike 

UI User Interface 

USB Universal Serial Bus 

 

 

Back to Table of Contents 
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Discover the comprehensive range of professional dictation products from Philips 

www.philips.com/dictation  
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